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Creating a New Workbook in Excel 

 

When opening MS Excel for the first time, you will see an Excel window with 

a green pane on the left. Workbooks recently accessed will be listed there. You 

will also see a couple of templates that can be used. Click on the blank 

workbook thumbnail to open a new workbook in Excel. 

 

 
 

You should immediately save the workbook under a name suitable for the 

type of workbook you are creating. Keep the file name short and sweet, but 

descriptive enough so you’re able to find it at a later stage. For instance, if 

you are creating a budget for the month of January 2019, name it 

budget_march_2019.xlsx, where the “.xlsx” is the file extension automatically 

added by Excel. 

 

budget_march_2019.xlsx 
  

            file name      default Excel extension 

 

Columns are labelled A, B, C, etc. Rows are labelled 1, 2, 3, etc. Each cell in 

the workbook has an address, for instance, C12, which means the cell is 

located in row 12 of column C. You can hide/delete a column/row by right 

clicking on it and choosing Either hide or Delete. 

You can change the worksheet name or hide/delete the worksheet by right 

clicking on it and choosing Rename/Hide/Delete. 

You can also insert columns/rows in the same way. 
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How to Save a New Workbook 

 

You can save a new workbook by following these steps: 

 

▪ Click on the File tab in the ribbon 

▪ Click Save As 

▪ Click Browse to navigate to the place you 

want to save it 

▪ Give the file an appropriate name 

▪ Click Save 

 

Thereafter, save your workbook every two to 

five minutes to prevent losing your work due to 

a power outage or a non-responsive program. 

The shortcut for saving is <ctrl><s> or click on 

the  symbol in the top left corner. 

 

How to Save a Workbook in a Different/Older Format 

 

It is sometimes necessary 

to save a workbook in a 

different format, example, 

as a .pdf file or an older 

version of the same file in 

order to open it with Excel 

2003, for instance. To 

save a file as .pdf is very 

useful, especially if you do 

not want the file to be 

edited once you send it to someone. Also, anyone is able to open it if they have 

a PDF Reader installed on their computers.  

 

You can save a file in a different format by following these steps: 

 

▪ Click on the File tab in the ribbon 

▪ Click Save As 

▪ Click Browse to navigate to the place you want to save it 

▪ Click on the dropdown list, Save as type 

▪ Choose the type of file you want to save it as 

▪ Click save 
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The Home Tab 

 

All your basic editing options of a workbook is found in the Home tab. 

 

Clipboard Group 

 

You can cut/copy a selection of text or a cell in an Excel 

workbook by selecting the text/cell and clicking copy 

or cut.  

 

If you want to keep a copy of the original text in the 

same place or make a duplicate, you will select copy.  

 

If you want to move the text/cell, you will select cut. Alternatively, the 

keyboard shortcut for cut is <ctrl><x> and copy is <ctrl><c>. 

 

Place the cursor where you want to place the selected text/cell and click on 

paste. Alternatively, use the shortcut <ctrl><v>. 

 

Font Group 

 

In the font group, you can do the following: 

 

▪ Change the font style 

▪ Change the font size 

▪ Change the font colour 

▪ Bold, italics and underline text 

▪ Change the fill colour of the cell  

▪ Insert cell or range borders 

 

Alignment Group 

 

Horizontal Cell Alignment 

 

You can left, centre or right align a cell, 

by choosing the correct alignment in the alignment group.  

 

Vertical Cell Alignment 

 

You can top, centre or bottom align a cell vertically, by choosing the correct 

alignment in the alignment group.  
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Indentation 

 

You can increase or decrease the cell indentation by clicking on the relevant 

icon in the alignment group. Notice how the text doesn’t 

start right next to the cell border. 

 

Cell Orientation 

 

You can change the text orientation of a 

cell by clicking on the Orientation icon 

in the alignment group.  

 

Wrap Text 

 

You can wrap text a cell to allow 

text to continue to the next line of 

the cell as shown in the example. 

 

Number Group 

 

In the Number group, you can change 

the cell to allow different formats, for 

instance, you can add an ‘R’ symbol 

for currency without having to type 

the R in front of a number.  

 

Note that you can only do calculations in Excel if it recognizes 

the value you entered as a number. If you manually add an ‘R’ 

symbol, Excel will recognize the value as text.  

 

Number Formats 

 

Numbers can be changed to view a certain number of decimals, 

as shown in the example, using the number 5.763. Note how the 

original value is still shown in the formula bar, even though the 

rounded value is displayed in the cell. You can also change the 

value to a percentage, for example 25%. 

 

Currency 

 

As explained above, you can change the currency to a symbol 

of your choice without changing the value entered in the cell. 
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Date and Time 

 

You can change the date and time formats 

without having to type each one out 

individually. If you can’t find the format 

you are looking for, you can customize the 

format as well, for example, the format dd-mmm-yy will display it as 30-Mar-

19 and dd/mm/yyyy will display 30/03/2019. In the same way, time formats 

can be customized, for example, the format hh:mm:ss will display 08:30:25. 

 

Text 

 

Sometimes, you need a number to be treated as 

text, for example a phone number. Excel won’t 

recognize a zero (0) in front of a number. Therefore, if you want the cell to 

display the number, you must format the cell to text first. 

 

Increase and Decrease Decimals 

 

You can increase or decrease the decimals of the value displayed in 

the cell by choosing either one of the icons shown on the left. 

 

Styles Group 

 

 
 

Conditional Formatting 

 

When you need to format a range according to a 

specific criterion, you can use the conditional 

formatting tool in the Styles group.  

 

For example, a teacher 

could highlight all the 

marks above 79 green 

and all the marks 

below 40 red as shown.  

 

Note that you can also do Top/Bottom rules and 

Data bars. 
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Format as Table 

 

You can choose a table style using this tool as shown in the example.  

 

 
 

Cell Styles 

 

Individual cells can be formatted using pre-set cell styles, which can be found 

in the Styles group. 

 

 
 

Cells Group 

 

Here you can format, insert or delete cells, rows and 

columns. Alternatively, you can also right click on the cell, 

row or column and perform the same task. 
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Editing Group 

 

AutoSum  

 

This automatically allows you to 

insert basic functions by highlighting a range of values and 

choosing what you would like to do, such as adding the values, 

finding the average, finding the highest value or lowest value 

in the range. 

 

Fill 

 

This tool allows you to fill a series automatically, such as numbers ranging 

from 1, 2, 3, etc. or days of the week, example Mon, Tue, Wed, etc. or months 

in the year, example Jan, Feb, Mar, etc. 

 

Alternatively, you can enter the first two values in a range and 

then click in the right corner of the second cell (your cursor will 

look like a + sign) and drag down as far as you need to fill the 

series down or across. This is shown in the screenshots. It will 

then fill down to the rest of the cells. 

 

Clear 

 

The clear tool allows you to clear formatting in cells, clear cell 

contents, hyperlinks and comments.  

 

Alternatively, you can click on a cell and press delete in order 

to clear its contents. 

 

Sort and Filter 

 

To sort a range in Excel, highlight all 

the data you want to include in your 

sort. Also include your headings if you 

have some. Click on the Sort & Filter 

icon and choose custom sort. See 

example: 

 

Highlighted data before sort. 
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Choose which columns you want to sort on. You can add as many levels of 

sorting as required. In the example, the data is first sorted by Band/Solo and 

then alphabetically by surname. Notice the result of the sort as shown below: 

 

 
 

You can also filter data in Excel, by placing filters on the data headers and 

choosing which data you wish to display. 

 

 Before filter is applied to column C. 

 

 

 After filter is applied to column C. 

 

 

 

 

 

 

 

 

 

 

Find and Select 

 

Using this tool, you can 

find and replace any 

word in Excel. This is 

used if you want to make 

multiple replacements of the 

same word or phrase. You can 

also custom format a cell containing certain texts or values. 
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Insert Tab 

 

The insert tab is mainly used to insert images, shapes, screenshots, pivot 

tables and charts. 

 

Tables Group 

 

Pivot Tables 

 

Use a pivot table to build a list of unique values. Because pivot tables 

summarize data, they can be used to find unique values in a field. This is a 

good way to quickly see all the values that appear in a field and also find 

typos, and other inconsistencies. In the example below, a basic table was used 

to show the ages of a group of students. A pivot table was then used to 

summarize the data and calculate and show the average age of the group of 

students. You can choose which data you want to summarize and if you want 

to display your pivot table in the same or different worksheet. 

 

 Table 

 

 

                                                                                                          Pivot   

 table 

 

 

 

 

 

 

 

 

 

 

 

Illustrations Group 

 

Pictures 

 

To insert a picture from your library: 

 

▪ Click on the Pictures icon  

▪ Navigate to the place where the picture is saved  

▪ Click insert. 
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Once a picture is inserted and selected, the Picture Format tab will appear in 

your Ribbon. 

 

 
 

In the Format tab, you can do the following: 

▪ Add an artistic effect 

▪ Crop the picture 

▪ Add a border 

▪ Change the size 

 

Shapes 

 

You can add any shape by clicking on the Shapes icon, such as a rectangle, 

circle, arrow, callout, etc.  

 

 

 

SmartArt 

 

This tool can be used if you want to insert basic lists, cycles or flowcharts. 

 

 
 

Screenshots 

 

A screenshot is the whole or part of 

the screen. If you select screenshot, 

it will take you to the underlying 

document or screen.  

 

 

Once you have drawn the shape, you can change its colour or add text. 
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Charts Group 

 

How to Create a Basic Chart 

 

▪ Create a table using at least two sets of data for your x and y axis. 

▪ At least one set of data must be values. (see examples below) 

▪ Select the data including your headers if you have any. 

▪ Click insert and choose the type of chart you want. You need to decide 

which chart would be best to display your results. 

▪ You can then choose if you want to keep the chart in the same sheet or 

move it to a different worksheet. 

 

Column Chart 

 

 Chart title 

 

   Gridlines 

  

   Data bars 

 

  Axis 

 

 

Pie Chart 

 

 

 Chart area 

 

 

 

 

 

 Legend 

 

Formatting a Chart 

 

Once you have inserted your chart and your chart area is selected, you will 

be given two new ribbons to work with: Design and Format. 
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In the Design ribbon, you can change the chart using the various styles 

available as shown in the screenshot.  

 

 
 

In the Format ribbon you can change various aspects of the chart, such as 

the fill colour or style of each ‘bar’ or ‘slice’ of the chart. You can also add 

standard shapes. 

 

Note: You can right click on any aspect of the chart and format it. 

 

Links 

 

You can insert a link to any place within the same sheet or workbook, another 

file, email address or a website. 

 

▪ Click on the cell where you want to place your link 

▪ Click on insert. 

▪ Click on link, insert link. The following box will appear: 

 

 
 

▪ Choose where you want to link to and click Ok. 
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Comments and Notes 

 

Sometimes you want to add a comment to a cell. You can do this by choosing 

Insert, Comment. Alternatively, you can also right click on the cell and choose 

New Comment. 

 

 
 

Once you click on the green arrow, it will post the comment and other users 

can reply to the comment: 

 

 
 

You can also add a note to a cell by right clicking on the cell and choosing 

New Note. 

 

 
 

Text Group 

 

Text Box 
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Word Art 

 

Insert a WordArt title to your sheet by choosing the WordArt option. A new 

ribbon will pop up that will allow you to format your WordArt. 

 

 
 

Headers and Footers 

 

In the text group, you can select the Header and Footer icon. This will 

change your page to Page Layout view that will enable you to see the 

header and footer section of your page.  

 

Click on the left, centre or right section of the header or footer in order to 

insert the field, text or image you need, which can be found in the new Header 

and Footer Tools ribbon that is activated. 

 

In the example below the current date and sheet name fields are displayed in 

the header. Note that these fields are not manually typed in, but rather 

selected from the Header and Footer Elements group. 

 

 
 

To switch back to normal sheet view, click on View, Normal. Even though the 

header and footer is not visible anymore, you will be able to see it when the 

worksheet is printed or previewed.  
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Symbols Group 

 

Equations  

 

For mathematical question papers, the Equations option 

is very useful. When clicked on, the following menu 

appears: 

 

Symbol 

 

When you need to insert special characters, click on the 

symbols icon. The following options appear for normal text 

amongst many others: 

 

When you want other special symbols, select the Webdings 

or Windings 1, 2 or 3 font in the Font dropdown list. 

 

 

Page Layout Tab 

 

In the Page Layout tab, you can change the margins, orientation and page 

scaling amongst other features. 

 

Page Setup Group 

 

Orientation 

 

Choose the page orientation, portrait or landscape. This is only needed if you 

want to print the file or publish it in another format, like PDF. 

 

Size 

 

Choose the size of your page, for example A4, A3, etc. Once again, it will only 

be needed if you want to print the file or publish it to PDF. 
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Breaks 

 

Insert page breaks using this tool. To change or remove breaks in a document, 

you must go to View, Page Break Preview. In this view, it is easy to see where 

breaks have been inserted. 

 

Margins 

 

You can choose pre-set margins for your page. If you choose custom margins, 

a dialog box will pop up with more options. 

 

 
 

If you click on the Page tab, you can scale the worksheet according to how 

you would like it printed. If you want to print the whole worksheet on one 

page, you can set it to print one page wide by one page tall. 
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Formulas Tab 

 

One of the main features that Excel has to offer, is the ability to do simple and 

complex calculations. 

 

All functions and formulas must start with an = sign and is displayed in the 

Formula bar. 

 

Formulas 

 

A formula is a calculation that the user tells Excel to perform. You make use 

of standard mathematical operators to do these calculations. The general 

mathematical rules apply when creating a formula: BODMAS (Brackets, Of, 

Division, Multiplication, Addition and Subtraction). 

 

The following operators are used in formulas: 

 

Addition   + example =A1+B1 

Subtraction   – example =B2-A2  

Multiplication  * example =A7*B7 

Division   / example =B7/A7 

Brackets   ( ) example =(A1+B1)/50 

Power   ^ example =A7^2 This will square the value in A7 

 

Always make use of cell references (A5, B7, etc.) containing values instead of 

entering a value in a formula wherever possible. Below is an example: 

 

 
 

Even though both formulas will return the correct value, the formula entered 

in cell D2 won’t be correct anymore if the quantity in cell B2 was changed to 

30 for example, whereas the function in cell D3 would still work if the value 

in cell B3 changed from 100 to 150. 

 

Note: Never enter a formula one by one. Once you have inserted a formula in 

D2, you should be able to copy it down to all the following cells by simply 

placing your cursor on the bottom right corner of the cell and dragging down. 
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Here is an example of what happens to cell references if the formula is copied 

down to the rest of the cells. 

 

 
 

Note how the cells automatically change the cell references as you go down: 

B2 becomes B3, then B4, etc. 

 

Sometimes you don’t want cells to change when you copy a formula. In these 

cases, you need to make use of absolute cell referencing. This is done by 

inserting a $ sign in front of the cell references you don’t want to change. For 

example $B$12.  

 

 
 

Notice how C1 stays C1 when it is copied down to the rest of the cells, but B4 

still changes to B5 then B6, etc. 

 

You can also combine values in a formula if you don’t have the values in the 

cell. For example, if you didn’t have the rate per hour available in the 

worksheet, you could have inserted the following formula in cell D4: 

=B4*20 

 

This works perfectly well, but if the rate per hour had to change, all the 

formulas would have to be updated. 
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Functions 

 

Excel offers many different functions 

that you can choose from. The most basic ones are SUM, MAX, MIN and 

AVERAGE. See the example below: 

 

The functions inserted in cells C11, C12, C13 and C14 will return the values 

according to the function entered. A function always starts with an = sign, 

followed by the name of the function, followed by a bracket. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Results 
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The following table contains a summary of all the functions you need to 

master from grade 10 to grade 12. 

 

FUNCTION GRD DESCRIPTION EXAMPLE 

Sum 10 Calculates the sum or total. =sum(A1:A5) 

Max 10 Calculates the maximum 

value. 

=max(A1:A5) 

Min 10 Calculates the minimum 

value. 

=min(A1:A5) 

Average 10 Calculates the average 

value. 

=average(A1:A5) 

Count 10 Counts the number of cells 

in a range that contain 

values (numbers) only. 

Dates are also regarded as 

numerical values. 

=count(A1:A5) 

Counta 10 Counts the number of cells 

in a range that contain 

numbers or text (cells that 

are not blank). 

=counta(A1:A5) 

Countblank 10 Counts the number of 

empty cells in a range. 

=countblank(A1:A5) 

Countif 10 Counts the number of cells 

in a range that comply with 

a specific criterion. 

=countif(A1:A5,”>5”) 

=countif(A1:A5,”M”) 

Rand 10 Returns a random number 

(fraction) between 0 and 1. 

=rand() 

Randbetween 10 Returns a random whole 

number between two 

numbers you specify 

(endpoints included) 

=randbetween(5,100) 

Mode 10 Returns the number that 

occurs most frequently in a 

range of data. 

=mode(A1:A5) 

Median 10 Returns the number in the 

middle of a set of sorted 

numbers. 

=median(A1:A5) 

Today 10 Returns the current date. =today() 

Now 10 Returns the current date 

and time. 

=now() 
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FUNCTION GRD DESCRIPTION EXAMPLE 

Round 11 Rounds a number to the 

nearest decimal place 

specified. 

=round(A2,2) 

Large 11 Determines the Nth largest 

number of all values in a 

range. 

=large(A1:A5,2) 

Small 11 Determines the Nth smallest 

number of all values in a 

range. 

=small(A1:A5,3) 

Power 11 Raises a number to a power 

(52). 

=power(5,2) 

Sumif 11 Values of certain cells in a 

range are added, if a certain 

criterion to the data is met. 

=sumif(A1:A5,”M”, 

  C1:C5) 

If 11 

 

Allocates a value to a cell 

according to the result of a 

condition. 

=if(condition,value if true, 

value if false) 

=if(D2>5,”Bonus”, 

  ”No Bonus”) 

 

Rounddown 12 Rounds a number down to 

N places after the decimal 

point. 

=rounddown(2.78,1) 

Roundup 12 Rounds a number up to N 

places after the decimal 

point. 

=roundup(2.783,2) 

Int 12 Rounds a number down to 

the nearest integer (whole 

number) 

=int(22.76) 

Trunc 12 Removes the decimal part of 

a number to N places after 

the decimal point. Unlike 

Int, Trunc does not round 

the remaining decimal 

places or whole numbers up 

or down. 

=trunc(21.73,1) 
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FUNCTION GRD DESCRIPTION EXAMPLE 

Nested If 12 The If function can be 

straightforward like shown 

previously, but can be 

extended when you have 

more conditions and 

outcomes. It is possible to 

have up to 64 If statements. 

=if(D2>800,”Gold”, 

  if(D2>=600,”Silver”, 

  “Bronze”) 

Vlookup 12 Looks for a value in the 

leftmost column of a table, 

and then returns a value in 

the same row from a 

column you specify. By 

default, the table must be 

sorted in an ascending 

order. 

=vlookup(C2, 

  $F$1:$G5,2,FALSE) 

 

TRUE =  Approximate   

              match 

FALSE = Exact match 

Hlookup 12 Looks for a value in the top 

row of a table or array of 

values and returns the 

value in the same column 

from a row you specify. 

=hlookup(C2, 

  $F$1:$J$2,2,FALSE) 

 

Len 12 Determines the number of 

characters in a string. 

=len(A2) 

Concatenate 12 Combines multiple strings 

into a single string. A 

maximum of 30 items can 

be combined. 

=concatenate(A2,  

  ” “,G2) 

Upper 12 Converts letters in a string 

to upper case. 

=upper(G2) 

Lower 12 Converts letters in a string 

to lower case. 

=lower(G2) 

Left 12 Extracts the left N 

characters of a string. 

=left(C2,3) 

Right 12 Extracts the right N 

characters of a string. 

=right(C2,3) 

Mid 12 Extracts N characters from 

the Mth position in a string. 

=mid(B2,3,2) 

Find 12 Returns the position of a 

substring within a string. 

=find(“ “,A1) 

Value 12 Converts a string that 

represents a numerical 

value to a number. 

=value(A1) 
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Note that if you click on the fx icon, you can view all the available functions 

with their descriptions. 

 

 
 

Defined Names 

 

As you have seen, cells have predefined names, 

for example A1, C12, D24, etc. A range is 

defined as a set of cells, for example A1:B12. 

 

You can define your own cell or named ranges, by using the Define Name tool 

in the Defined Names group. 

 

▪ Click on the cell or highlight the range you want to name. 

▪ Click on Define Name. 

▪ Type in the name you want to give the cell or range – no spaces may be 

used. 

 

 
 

In the above example, the new name HourlyRate was given to cell C1. Note 

that it doesn’t say C1 anymore in the name block. 
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Data Tab 

 

Data Validation 

 

In order to prevent incorrect data from being 

entered in a spreadsheet, you can apply Data 

Validation to a cell or range. 

 

Drop Down List 

 

Do the following to create a drop-down list / combo box in a cell: 

 

▪ Create a separate list of data you want available in your list. This can 

be done on the same sheet or on a different sheet. 

▪ Select the cell or highlight the range where you want your combo box. 

▪ Select Data Validation. 

▪ Choose List. 

▪ Select your source and highlight the range where your list items are 

found.  

▪ Click Ok. 

 

 Data source 

 E2:E3 

 

 

 

 Combo box 

 

 

 

 

 

 

 

 

 

Text Length 

 

To only allow a certain number of 

characters to be entered in a cell, you can 

specify the text length as shown on the 

right. If more or less characters are entered, 

an error message will pop up. 
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Review Tab 

 

Proofing Group 

 

You can use the spelling option in the proofing group to check 

your spelling in a spreadsheet. 

 

Protect Group 

 

Sometimes you only want users to be able to 

edit certain areas in a spreadsheet. This is 

especially handy if you made use of long, 

complex calculations and you don’t want a 

user to be able to make changes to those 

calculations.  

 

You can do this by following these simple steps: 

 

▪ Select the cells you want a user to be able to edit. In my example I have 

selected the range A4:B9. 

▪ Right click on the selected cells/range. 

▪ Choose Format Cells and then select the Protection tab. 

▪ Untick the Locked check box and click Ok. 

 

 
 

▪ Click on the Protect Sheet option. 

▪ Untick the Select Locked Cells checkbox.  

▪ Add a password in the password box. This is 

optional. Click Ok. 

▪ You will now only be able to edit the range or 

cells that you “unlocked”. 

▪ You can remove the protection again by 

choosing the Unprotect Sheet option. 
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View Tab 

 

Workbook Views Group 

 

Choose the different views here as discussed 

previously under Breaks and Headers and Footers. 

 

Show and Zoom Groups 

 

Choose what you want to show on your 

workbook and zoom in and out here. 

 

Freeze Panes 

 

When you have many rows or columns of data 

and you want a certain number of top rows or 

columns to the left to freeze when scrolling down 

or to the right, you can use the Freeze Panes 

option in the Window group. This is particularly 

useful if your data contains headers. 

 

▪ Place your cursor below the row or to the right of the column you want 

to freeze. 

▪ Select Freeze Panes.  

▪ Alternatively you can also just opt to freeze the top row or first column. 

 

Printing a Worksheet / Workbook 

 

Follow these steps to print a document: 

 

▪ Click on File 

▪ Click Print <ctrl><p> 

▪ Review your worksheet before printing 

▪ Choose the correct printer, paper size/scaling 

▪ Make sure you are printing the correct sheet 

and not the entire workbook if you don’t need 

it. 

▪ Scale the worksheet if needed. 

▪ Select the relevant pages you need to print. 

▪ Print on both sides to save paper. 
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Protecting (Encrypting) a Workbook 

 

You can Encrypt a workbook by following these steps: 

 

▪ Click on File 

▪ Protect workbook 

▪ Encrypt with password 

 

Developer Tab 

 

To enable the Developer Tab: 

 

▪ Click File, Options 

▪ Customize Ribbon 

▪ Check the box next to Developer Tab 

 

Controls Group 

 

You can also add checkboxes, option buttons and other content controls like 

you can do in Microsoft Word.  

 

 
 

Macros 

 

A Macro can be defined as a single instruction that expands automatically 

into a set of instructions to perform a particular task. 

 

How to record a macro using a shortcut key 

 

▪ Select Record Macro on your Developer Tab. 

▪ Give your Macro a descriptive name according to what you want your 

macro to do. (In the example used, the recorded macro must calculate 

the average of a set of class marks in cell B13.) 
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▪ Add a shortcut key if you are not going to assign your macro to a button. 

(In the example, <Ctrl><m> is used, since it is not a commonly used 

shortcut. 

▪ Give a suitable description for your macro so that any user can see what 

your macro is meant to do. Click ok. 

 

 
 

▪ Now you can record your macro. Every cell you click and every change 

you make will be recorded. (In the example, cell B13 is selected and the 

function =average(B2:B12) is inserted in the cell.) 

▪ Stop recording. 

▪ Now you can remove what you have done, but whenever the shortcut 

key is pressed, Excel will mirror what you have recorded. 

 

Viewing and Editing a Macro 

 

You can view your workbook macros by clicking on the Macros icon. To edit 

your macro, you can choose Visual Basic and change the aspects you want to 

edit. 
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How to link a macro to a button 

 

▪ Record your macro. You don’t have to add a 

shortcut key. 

▪ Select Insert on your Developer Tab and choose 

Button (Form Control).  

▪ Draw your button where you want it on your 

worksheet. 

▪ Select the macro you want to assign to your 

button and click Ok. 

 

 
 

▪ Give your button a suitable label. 

 

 
 

▪ Whenever the button is clicked, the macro will run. 
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Keyboard Shortcuts 

 

General 

 

New document .................................................. <Ctrl><N> 

Open document ................................................ <Ctrl><O> 

Print ................................................................. <Ctrl><P> 

Save .................................................................. <Ctrl><S> 

Close a document ............................................. <Ctrl><W> 

Select all ........................................................... <Ctrl><A> 

Find .................................................................. <Ctrl><F> 

Help .................................................................. F1 

Hide selected row .............................................. <Ctrl><9> 

Hide selected column ........................................ <Ctrl><0> 

 

Editing 

 

Cut ................................................................... <Ctrl><X> 

Copy ................................................................. <Ctrl><C> 

Paste ................................................................. <Ctrl><V> 

Undo ................................................................. <Ctrl><Z> 

Redo ................................................................. <Ctrl><Y> 

 

Formatting 

 

Bold .................................................................. <Ctrl><B> 

Italics ................................................................ <Ctrl><I> 

Underline .......................................................... <Ctrl><U> 

Align left ........................................................... <Ctrl><L> 

Align right ......................................................... <Ctrl><R> 

Align centre....................................................... <Ctrl><E> 

Justify .............................................................. <Ctrl><J> 
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Excel Error Codes 

 

ERROR LIKELY CAUSE SOLUTION 

#VALUE! Excel displays the #VALUE! error 

when it finds spaces, characters, or 

text in a formula where it is 

expecting a number. Excel requires 

formulas to contain numbers only 

and won't respond to formulas 

associated with text. 

Double check your 

formula to make sure 

that you only used 

numbers. If you're still 

seeing an error, check for 

blank cells, missing 

formulas linking to cells 

or any special characters 

you may be using. 

#DIV/0! When you see #DIV/0!, you are 

asking Excel to divide a formula by 

zero or an empty cell.  

Change the value of the 

cell to a value that is not 

equal to 0 or add in a 

value if your cell was 

blank. 

#NAME? This error message appears if Excel 

can't understand the name of the 

formula you're trying to run.  

To fix the #NAME? error 

in Excel, check the 

spelling of the formula 

you're trying to run.  

#REF The #REF! error in Excel appears if 

you're running a formula that is 

referring to a cell that doesn't exist. 

If you delete a cell, column, or row 

in your spreadsheet, and build a 

formula including a cell name that 

has been deleted, Excel will return 

the #REF! error in the cell. 

Before you paste over a 

set of cells, make sure 

there are no formulas 

that refer (hence, "REF") 

to the cells you're 

deleting.  

#NUM If your formula contains numeric 

values that aren't valid, you'll see an 

#NUM! error appear in Excel. This 

happens when you enter a numeric 

value that's different than the other 

arguments used in your formula. 

Check to see if you have 

entered any formatted 

currency, dates, or 

special symbols. Then, 

make sure to remove 

those characters. 

####### When you see ##### displayed in 

your cell, it can look a little scary. 

The good news is that this simply 

means the column isn't wide enough 

to display the value you've inputted. 

Click on the right border 

of the column header and 

increase the column 

width. 

Source: https://blog.hubspot.com/marketing/common-excel-error-messages 


